
Empowering Teachers for a more Interactive,
Efficient and Appealing Digital Learning

Experience 

TRAINING FORMAT



03

05

08

09

19
29

INTRODUCTION
The project 
Digit&Learn specific objectives
Training Format 

RESEARCH REPORT   
Desk research conclusion
Field research conclusion 
Conclusion, Recommendations, Key Findings

TRAINING FORMAT IMPLEMENTATION
The basic structure
Division of duties Table

TRAINING MODULES

BEGINNER

1 - ICT and Digital Literacy (Turkiye)

2 - Beginner ICT Tools (Lithuania)

3 - Complex ICT Tolols (Italy)

INDEX



ADVANCED

4 - Developing Digital Content (Lithuania)

5 - Integrating and re-elaborating digital content (Romania)

6 - Integrating ICT and Digital content into teaching (Finland)

EXPERT

7 - VR Literacy and Features

8 - VR Content Development

9 - VR Tools for Teaching

34
53
80

126
132
147



THE PROJECT
Through the “Empowering teachers and professors for a more interactive, efficient and

appealing digital learning experience” (Digit&Learn) project, the Consortium of partners will

support teachers and professors in a digital up-skilling journey. This will enable them to exploit

the potential of digital means and technologies to create educational tools. This will be

complementary to their teaching. For instance, technologies as Virtual Reality (VR) are starting

to have a greater impact in school classrooms, in many countries, as they increase in

sophistication. Also, costs are reduced. In considering virtual reality, the low immersion also

referred to as “In desktop VR, the virtual reality environment (VRE)” is displayed on a

conventional PC monitor with sound coming through speakers and the interaction is

controlled through a regular computer mouse, without any expensive costs needed for its

implementation. In addition, the use of games and gamification are important mechanisms

that support learning. Games provide participants with opportunities to learn from their

involvement within a structured experience.

DIGIT&LEARN SPECIFIC OBJECTIVES
Objective 1: Up-skill teachers with digital and technological competencies that will enable

them to create educational tools aimed at supporting their classes; 

Objective 2: Activate a process of co-creation with teachers aimed at designing digital

tools based on new technologies as complementary teaching means. 

Objective 3: Elaborate assessment means to monitor the impact of new technologies digital-

based educational tools on students learning achievements.
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TRAINING FORMAT
The Training Format (R1) for teachers is aimed at providing them with competencies for

content creation through digital technologies. 

 

The Training Format is aimed at helping teachers to improve their digital skills, and to develop

digital tools, e.g. VR-based, to be used during lessons that are tailored to the needs of

students. The elaboration of the Training Format’s modules will be strictly based on a Research

Report, containing training needs of teachers regarding digital or technological literacy as well

as an overview of existing solutions in the field of digital tools applied in educational settings. 

The Training Format will be based on a blended approach including in person and online

activities structured on three levels: Beginner, Advanced, Expert. Each level will have specific

modules as follows:  

BEGINNER
a)Beginner ICT and Digital Literacy; 

b)Basic ICT tools; 

c)Complex ICT tools. 

ADVANCED

a)Developing Advanced Digital Content; 

b)Integrating and re-elaborating digital content;

c)Integrating ICT and Digital content into teaching.

EXPERT

a)Expert VR Literacy and Features; 

b)VR Content Development; 

c)VR Tools for Teaching.
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The Training Format will be tested at national level during the pilot phase with the involvement

of 5 teachers per Country aged 25+ with at least 2 years of experience in teaching (from

primary and secondary levels). An important element of the Training Format will be the co-

creation process between partners and the teachers trained through the piloting of the R1,

aimed at creating new developed digital and virtual tools to be employed during lessons for a

selected sample of school subjects to be included in the Toolbox. Due to its features, the

Training Format can be potentially exploited by different types of educational institutions for

different subjects and applied to other sectors than school (i.e. adult education, VET). 

 

Training Format Development – All partners will cooperate to create, structure, and elaborate

the Training Format. All partners will provide their contributions for the contents of the modules

as well as the translation in their national languages under the supervision of Mine Vaganti

NGO.

In this section, the Research Report’s conclusion, containing training needs of teachers in

digital/technological literacy as well as the mapping of existing offer in the frame of digital

and VR tools applied to education, are reported. The Training Format implementation will be

based on the findings of this grounding research. 

DESK RESEARCH CONCLUSION
All partner countries were looking for examples of good practice according to the research

topic. Practical examples show that digital education plays a very important role in every

country.

Practices for educational communities are focused on the improvement of teachers'

professional competences and the use of creative and innovative methods. They encourage

to increase the teacher's awareness, make him/her aware of his/her strengths and

weaknesses, ensure that the teacher develops a his vision and to builds confidence in using

technologies in the classroom. 
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With the help of these projects, teachers can raise students' interest in science and

technologies. This is especially relevant in a world which is increasingly formed by

technologies and digitization.

Several projects were intended to provide equal opportunities to vulnerable groups. They were

reducing the gap between different age groups and between people of different abilities. The

projects were intended for disabled or retired people. Also, for those with lower incomes.

The aim is to help residents learn how to use information technologies and the Internet with its

opportunities effectively, safely and responsibly.

Thousands of people participated in the projects. A new public fiber-optic Internet access has

appeared. Websites for learning and teaching have been created. Many innovative teaching

tools have been prepared.

FIELD RESEARCH CONCLUSION
Questions 10-20 are about digital literacy. Only 1% of teachers indicated that they had no

digital skills, 23% had a beginner level, 58% had an intermediate level and 19% had an

advanced level. 35% of teachers did not study digital literacy and only 21% were in degree

programs, while 44% were in non-formal studies. In all countries, it is common for teachers

learning digital literacy to look for information on the Internet or participate in various

seminars and training. Very little information is received by teachers from their education

department. But the teachers themselves are reluctant to share the digital tool, plans or other

information they have created. 55% of respondents consider it very important and 33%

important to regularly learn and improve their personal digital knowledge and competences.

40% would very much like and 32% would like to attend a seminar/workshop/informal training

on digital learning/digital tools for education in the future. 17% do not know if they would like to

attend such training, and 11% would not participate at all. 85% of teachers use digital tools in

their lessons. In all countries, teachers use Google Docs, Edmodo, Power Point, Kahoot, Quizlet

and Youtube. There are many apps. Teachers indicated that they also use Canva or other

specific apps for mathematics, physics, etc. However, teachers have little or no use of VR in the

classroom. Internet search is very often used in lessons. According to teachers, the use of

digital tools in lessons increases students‘ motivation and improves students‘ performance.

Also, digital tools help to communicate and manage the lesson, but it does not really reduce

the workload of teachers. The main reasons why teachers use digital tools is to engage

students, this was noted by 299 teachers.
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CONCLUSIONS, RECOMMENDATIONS, 
KEY FINDINGS
To summarize the research, it can be said that in different countries with different educational

systems, as well as different national priorities, the qualifications of teachers and attitudes

towards digital tools are very similar.

Conclusions:

Teachers have a sufficient amount of digital skills. They are able to use digital tools

themselves.

1.

In all countries teachers understand the importance and impact of digital literacy on

students, and are therefore willing to develop their own digital competences. From the

conducted research, we can see that teachers use few different digital tools, only those

that are familiar to them. Regular upgrading of digital literacy skills is necessary, because

digital content is constantly and rapidly changing, and innovations are emerging.

2.

Most of the time, they use Google Docs, Edmodo, Power Point, Kahoot, Quizlet, Youtube,

Canva or other specific apps for mathematics, physics, etc. in lessons or when preparing

for them. However, teachers have little or no use of VR in their classrooms. Internet search

is very often used in lessons.

3.

Teachers share little or almost no digital material they have prepared, which would

facilitate the work of the teachers themselves. From the research, we see that there is a

need to encourage teachers to share their prepared digital materials, lesson plans, etc.

4.

The use of digital tools in the classroom has a positive effect on both teachers and

students compared to traditional methods. Obstacles to the use of digital tools in the

classroom are mostly technical. Insufficient number of tools and poor communication are

named as main obstacles.

5.

Recommendations:

Continuous improvement of the teacher's digital competences and skills.1.

To share experiences with colleagues in their school, local or national teacher

communities.

2.

Use digital tools as much as possible in lessons, because they enliven and make the lesson

more interesting and attractive for students.

3.
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THE BASIC STRUCTURE
The Training Format will be based on a blended approach including physical and online

activities structured on three levels, each other different by the kind of content developed in

them: Beginner, Advanced and Expert. 

The implementation of each Level will be, in turn, carried on by purchasing on three different

modules, each of which deepening the topic addressed in the specific level. As mentioned, the

Training Format is implemented thanks to activities aimed at involving and interesting the

participants through Non-Formal Education (NFE); that is why each module involves the use of

Ice Breakers, Team Building activities and Workshops. 

Each partner’s task will be to design each of the assigned activities (according to 

the table below), so that each module can be implemented in Training Format. As the

coordinator, Mine Vaganti NGO tried to assign the different activities to be designed according

to the specific skills and specializations of each partner. In any case, however, the balance in

the number of modules that each partner has to develop is guaranteed.

TRAINING FORMAT: DIVISION OF DUTIES TABLE

2

BEGINNER ADVANCED EXPERT

8

TRAINING FORMAT
IMPLEMENTATION

1.  ICT and     
     Digital         
     Literacy

2. Beginner
     ICT Tools

3. Complex 
     ICT Tools

4.  Developing 
      Digital Content

5. Integrating and 
     re-elaborating  
     Digital Content 

6. Integrating ICT 
     and Digital Content  
     into teaching

7. VR Literacy 
    and Features

8. VR Content 
     Development 

9. VR Tools for 
     Teaching

Team 
Building

Lithuania

Romania

Finland

Team 
Building

Turkiye

Lithuania

Italy

Team 
Building

Italy

Greece

Greece

Ice 
Breaker

Lithuania

Romania

Finland

Ice 
Breaker

Turkiye

Lithuania

Italy

Ice 
Breaker

Italy

Greece

Greece

Workshop

Lithuania

Romania

Finland

Workshop

Turkiye

Lithuania

Italy

Workshop

Italy

Greece

Greece

Between the Beginner ICT Tools that can be mentioned: 
For developing Literacy: Emails, Web searching, the use of digital videos
For presentation: google slides, slide share etc
For creative creation: Canva, Infogram, Storybird

Between the Complex ICT Tools that can be mentioned: 
For brand promotion and web marketing: Wordpress, SEO Language, Google analytics. 
For writing skills and effective writing delivery: Word and Excel 
For social promotion: Facebook and instagram management (content publishing, social branding, etc.)
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ICE - BREAKING ACTIVITY “ BINGO FOR DIGIT WORLD ” 

Category 

Timeframe

Learning outcome

Materials

Procedure 

Practical

15-20 mins

This ice-breaking activity aims to meet and talk to as
many people as possible within the time limit in order
to put one name by each of the statements . The
purpose of this icebreaker is to lower initial barriers and
improve interactions amongst participants.
Additionally, it could be a helpful activity to
comprehend how participants relate to ICT and
technologies. 

1. A piece of paper or a bingo card using a 5×5 table
and text boxes listing 10 to 15 characteristics. 

2. A copy of the paper / card for each participant. 

1. Prepare 10 to 15 characteristics using vocabulary that
are related to ICT and digital literacy. e.g. Find
someone who usually uses Firefox Browser. 

2. The draft “Bingo for Digit World” in annexes can also
be used. 

TRAINING MODULE

BEGINNER
1 - ICT and Digital Literacy (Turkiye) 
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3. Print a copy of the paper / card for each participant.

4. Hand out the copies to participants. 

5. Announce that the group is going to do a brief
interview activity in which each participant will ask
people a question to find out if they do a certain
activity. The goal is to ask everyone in the group until
participants find someone who does that activity or
has that characteristic. 

6. Ask participants to mingle and ask each other the
questions until they find someone who answers yes to a
question. 

7. When participants find someone who says yes to one
of their questions, they ask the person to write his/her
name and put his/her signature in the box. 

8. Then, they go on to the next question with another
person. 

9. The first person should shout “Bingo!” once all the
boxes are filled. The first person who fill all the boxes
with a name and signature is the winner. 

10. Then ask the learners to share their findings, for
example “Julie usually uses Firefox Browser”. 

Indications or
suggestions for the
trainers (if any) 

A digital version of this activity can be prepared. 

In Google Slides , create a bingo board using a 5×5
table and text boxes. 

Share the slideshow in Google Classroom or other
digital tools so that every participant receives their
own copy. 

In the bingo squares, write prompts to meet people
and get to know the group better. 
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FIND SOMEONE WHO
... checks her/his emails on

the smart phone every
morning 

...doesn’t have an email
address

...uses Bing as a search
engine

...doesn’t watch films or
shows on sites like Netflix

...has had an online date

...uses Firefox Browser as a
browser

...doesn’t know how to use
an application for

navigation 

...uses the web to connect
with distant family
members/ friends

...can create a website

...spends more than 4 hours
on social media sites like
Facebook or Instagram

…can create a video with an
application on smart phone

...listens to music on sites
like Spotify

...does online shopping
once a week 

...joins online courses
/training 

...can develop an
application

...doesn’t know “googling”
or searching the web for

information

...doesn’t have a Twitter
account

 ...uses the same password
for all online accounts 

...has more than 1K
followers on Instagram

...has attended training
about Cyber Security 
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TEAM BUILDING ACTIVITY- “FORM YOUR COMMUNITY” 

Category 

Timeframe

Learning outcome

Material

Procedure

Practical

20 minutes 

“Form Your Community” activity aims at helping
participants to know and understand the internal and
external hardware components of a computer and to
build a community among participants. 

Paper, post it, pens or markers 

PREPARATION 
The Teacher/Facilitator creates name cards for each
vocabulary listed below. Each card has two sides. The
name is on the front (i.e., Webcam) and a short
description is on the back (i.e., "a video camera
connected to a computer, allowing its images to be
seen by internet users"). 

The cards will be organized in 2 groups : 
1. Internal Hardware Components 
2. External Hardware Components

In-class 
The aim of the game is to find the components in the
same group and form two different communities.

Teacher/ Facilitator delivers name cards and wants
students (SS) to walk around the classroom and
describe computer components that are written on the
name card through role-playing to other SS. SS will not
talk, they will use only body language and gestures.

Example 1 
Student A will role play to describe ‘’Printer’’ 

Student B will guess what student A tells about. 
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Then student B will role play to describe ‘’Graphics
Card’’ 

Student A will guess what student B tries to describe. 

A printer is an external hardware component and
Graphics Card is an internal hardware component, so
student A and B can’t form a community because they
belong to different groups. ‘’Printer’’ and “Graphics
Card’’ will keep on looking for their community. 

Example 2; 
Student A will role play to describe ‘’Printer’’ 

Student C will guess what student A tells about. 

Then student C will role play to describe ‘’Monitor’’ 

Student A will guess what student C tells about. 

Both ‘’Printer’’ and ‘’Monitor’’ are external hardware
components, thus they can start to form their
community. Now they are expected to find other
members of the external hardware components
community. 

First formed component community will be the winner
of the team building activity. 

At the end of the activity, each component will
introduce itself 

Example ; 
I am a printer, I am an external component. I can print
on paper anything written or created on a computer,
whether it's text or a photo. 

I am a Graphics Card, I am an internal hardware
component. I am a type of expansion card that
processes and produces outputs for displays. I am a
crucial component that monitors rely on. 
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Indications or
suggestions for the
trainers (if any) 

THE MOTHERBOARD 

RAM 

THE PROCESSOR 

HARD DISK DRIVE (HDD) 

CD-ROM DRIVE 

A digital version of this activity can be prepared. 

In Google Slides , create a bingo board using a 5×5
table and text boxes. 

Share the slideshow in Google Classroom or other
digital tools so that every participant receives their
own copy. 

In the bingo squares, write prompts to meet people
and get to know the group better. 

The motherboard is a printed circuit board that houses
most, if not all of the internal components. These
include the Central Processor and the Memory cards
and more. 

RAM is a type of temporary computer data storage. The
more RAM you have, more windows and processes can
be open than if you only have little Ram.

The processor is a computer chip that carries out
instructions given by computer programs and handles
all the day to day tasks that a PC has to do.

The Hard Disk drive is a type of permanent computer
data storage. Data is retrieved by using a series of
rapidly spinning magnetic disks that store the data.

A CD Rom drive is a drive that reads compact discs
only, but now expands to DVDs as well.

INTERNAL COMPONENTS
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POWER SUPPLY 

MONITOR

FAN 

MOUSE

POWER CABLE 

KEYBOARD

PRINTER

GRAPHICS CARD 

SOLID STATE DRIVES
(SSD) 

The Power Supply unit is a switch operated unit that
converts mains AC electricity into DC electricity that
powers all the internal components. These units have
many cooling systems to them so that they do not
overheat. 

The monitor is the display for a PC. This is where
anything you can see is displayed. 

A fan inside a computer is a fan that sucks cool air into
the PC case and blows hot air out of the case and stops
any key components overheating.

The mouse is the primary way of navigating a
computer.

These cables are connected to the Power Supply Unit
and cables that look like this power the motherboard
and is the largest connector found on a PC’s
motherboard. Without these, the computer would not
work, so are an essential internal component.

The keyboard is the main way of typing on a PC. When
typed, each key produces a letter on the screen.

The printer is computer hardware that will print
anything written or created on a PC onto paper,
whether it be text or photos. 

The graphics card is a type of expansion card that
processes and produces outputs for displays. These are
a crucial component that monitors rely on.

Solid State Drives are drives that have no actual
mechanical parts and are a form of computer data
storage. Their construction resembles that of a giant
memory card found in digital cameras. 

EXTERNAL COMPONENTS
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COMPUTER CASING

USB FLASH 

WEBCAM

SCANNER 

MICROPHONE

SPEAKER

The computer casing is the housing for all the internal
components of the PC. These are usually made from
steel because they need to be durable.

A USB flash drive (also called a thumb drive) is a data
storage device that includes flash memory with an
integrated USB interface. 

A webcam is a video camera which is designed to
record or stream to a computer or computer network. 

A scanner is a device that captures images from
photographic prints, posters, magazine pages and
similar sources for computer editing and display.

An instrument for converting sound waves into
electrical energy variations which may then be
amplified, transmitted, or recorded. 

A computer speaker is an output hardware device that
connects to a computer to generate sound.

WORKSHOP - MY WEBWORLD

Category 

Timeframe

Learning outcome

Material

Procedure

Practical

40’+40’

The workshop aims at making Students (SS) to describe
how they and others use and interact on the web

Sticky notes 
Pencils, markers
Timer for keeping time during storytelling

In this workshop, SS reflect on and share observations,
ideas, and feelings about their own web use, and what
the web means to their communities. 
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What do they love or hate about the web? What are
they curious about? What kinds of things would they
like to do on/with the web? The workshop also helps SS
to get to know each other and feel connected.

Introducing the Web 

15 Mins. 
The teacher (T) / Facilitator (F) explains that SS will talk
about the internet and technologies they use when
they are “online’’. T/F asks the SS to share the kinds of
things they do “online.” 

T/F gives some samples to encourage students,
especially ones who have less or no web experience.

sending or receiving email 
using web for distance education 
using an application on a smart phones like maps,
readers and calculators 
searching the web to do homework 
streaming shows or music on sites like Netflix or
Spotify
gaming 
shopping 

T/F explains the internet can be used for several
different purposes and reasons and T/F elicits SS’s
examples about what they do when they are online. 

Storytelling: My Webworld
 [25 mins] 

In this part, T/F splits SS into groups of 3 to 4 to tell
and listen to stories. T explains that each student
will have 3-4 minutes to tell their own story of their
web experience and what it means to them while
other group members listen. 

T/F will write some questions on the board to inspire
SS to develop their own story. 
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What kind of things do you hope to do online? 1.
What kind of information do you hope to find online?
What would be most useful to discover or learn? 

2.

What’s the most important/meaningful/memorable
experience you’ve had online? 

3.

How do you use the web? What kinds of things do
you like to do online? 

4.

SS do not have to answer the questions, questions are
examples to show what kind of experiences they can
share and encourage them to talk about their
experience. SS will have 5 minutes to think about their
stories. SS will note keywords on a paper so they can
organize their stories without forgetting important
points while telling it. 

T/F tells SS they are free to set the tone and depth of
the story, they are just supposed to not to tell
offensive and aggressive stories. 

Between stories, SS needs to take time to relax and
others to understand the point of the story. 

Reflection and Review 
[20+20 mins] 

When SS have completed sharing their stories, the
T/F asks SS to assess the stories of other students
and their own learning ( differences/ similarities/
new reasons and purposes to use the internet etc). 

SS will answer questions like 
Is there anything new that you have learnt from the
stories? 

1.

Which story is the most interesting one for you why? 2.
Which story has similarities with yours, why? 3.
What was surprising in the stories? 4.
Which story was inspiring for you? 5.
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T can use responses to stories and questions to shape
the rest of the program– return to the questions for
context, examples, and to address gaps in knowledge
and understanding, or leverage special expertise– ie
“we had a question about how a browser works, so let’s
explore that now” or “some of you are active youtube
users– what can you tell us about the platform?” 

T thanks the SS for their participation, questions, and
opinions. 

Time frame of the activity is for classes with max 20
students, for more crowded groups, time frame needs
to be rearranged. ‘’Reflection and Review’’ part can be
done in writing or orally.

Indications or
suggestions for the
trainers (if any) 

ICE - BREAKING ACTIVITY “ THREE CHAIRS ” 

Category 

Timeframe

Learning outcome

Materials

Practical

15 mins

The aim of the activity is to get the participants to know
each other both personally and professionally. It is also
very important to emphasize that everyone should
know each other's expectations and aspirations.

Three chairs, cards, pens

2 - Beginner ICT Tools (LITHUANIA)
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Three chairs are placed in front of the group work room.
In front of each chair, cards with the inscriptions "About
myself", "About the profession", "Expectations" are
placed on the floor. The teacher is the first to sit on the
chair and tell the participants about himself. Each
contestant will have to introduce himself in all three
categories.After that, one by one, the group members
sit down and tell about themselves. As the participants
introduce themselves, during the introduction training
lead will write a contestants introduction (name,
profession, expectations). The cards will be already
premade to be filled with the information. Person to
place on the wall of them. 

The trainer could keep post-its and take notes on how
participants describe themselves for later activities.

Indications or
suggestions for the
trainers (if any) 

Procedure

TEAM BUILDING ACTIVITY “COUNTING WITHOUT THREES” BEGINNER

Category 

Timeframe

Learning outcome

Materials

Procedure

Practical

20 mins

 The aim of the activity is to help focus and to increase
team concentration

No materials are required

Everyone stands in a circle. The group must count to 25,
omitting the numbers with at least one triplet (3, 13, 23)
and those divisible by three (3, 6, 9, 12, 15, 18, 21, 24).
Instead the participants need to clap. The first
participant starts by saying "one", the next person says
"two", and the third claps, etc. 
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If someone makes a mistake (says a number, even
though they should have clapped), the game starts all
over. The game is over when you count to 25 without
mistakes. 

Indications or
suggestions for the
trainers (if any) 

WORKSHOP ACTIVITY - ICT TOOLS "CANVA"

Category 

Timeframe

Learning outcome

Materials

Procedure

Workshop

3 hours

Participants will learn how to use Canva, create
presentations, and learn about other Canva options

Internet

Canva is an easy-to-use graphic design platform that
allows you to create visual content, including social
media graphics, posters, flyers and more. And, it’s
available to use in your browser. After creating your
piece, it can be downloaded as an image file or PDF
and immediately shared or is ready to print. 

Logging into Canva 

1. Check your inbox for a welcome email from Canva.
Accept the invitation, and launch Canva in your web
browser.

(https://www.canva.com/). 
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2. Login with your credentials, using Google’s sign-in function

Choosing a Carleton template 
1. Go to Carleton College - Creative Team’s folder. 
2. Select your preferred template.

3. On the template screen, choose a template you want to
use and click on it. 
4. Select “use this template” and a copy of that template will
be made on a new window.
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1. Elements: Select photos, frames, shapes, lines, etc. to add
to your design.
2. Text tab: Beyond the text placeholders already available to
you, the text tab gives you options to add additional pre-
formatted text heads, sub-headings, and body text. There
are also font combinations available. 
3. Background tab: colors are available just below the search
bar. 
4. Uploads tab: This area allows you to upload your own
elements such as images and graphics.
5. Folder: All of your designs, favorites, purchases, items
shared with you, and folders are available here.
6. Home: Takes you back to your home page.
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7. File: Create a new design, show margins, show print bleed,
save all your changes, move to folder, resolve comments,
see version history, make a copy, download your design, or
look for help.
8. Resize: Allows you to change the size of your design.
9. All changes safe: While Canva automatically saves your
changes, much like Google Docs and Slides, this feature
gives you an opportunity to ensure your changes were saved
before closing out of the platform.
10. Document name: Allows you to change the naming
convention of your design at any time.
11. Share: Allows you to share your design with others. This
feature also gives you the flexibility to adjust restrictions,
allowing individuals to view or edit.
12. Download: This feature gives you different options and
formats to download your design in.
13. Publish: Download your design, share a link, make a
presentation, email the design, or share it on social media.
14. Add notes: Add notes to your design.
15. Page controls: If you have more than one page, use this
area to navigate between them. You also have the ability to
copy them and delete them.
16. Add a new page: Directly add new pages with this button.
17. Zoom Control: Make your work area larger or smaller.
18. Help: Access and use Canva’s support functionality, while
still working on your design.

Open and edit your design
1. To find your design, go to the department folder where you
saved your design (e.g. Division of Student Affairs).
2. Double-click on the template you selected. A screen will
open up, giving you the ability to modify your template.

Using the Canva sidebar
1. Search tab
The search option allows you to look for photos, Illustrations,
or all items. You can narrow your search down by clicking on
photos or illustrations.
2. Elements
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Here you’ll find photos, grids, frames, shapes, lines,
illustrations, icons, charts, and more.
To select an element:
1. Click on the elements tab.
2. Select a category you want to browse in.
3. Then drag and drop the element into the design area.

3. Grids
Used to hold images. Select the right grid depending on the
numbers of images you plan to use. You should also select
the grid layout that works for you e.g. for two images laid
horizontally, use the grid shown below:
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4. Text
Beyond the text placeholders already available to you, the
text tab gives you options to add additional pre-formatted
text heads, sub-headings, and body text. There are also font
combinations available.

Edit text
Highlight the text you want to edit and a top bar will appear
with different options to make adjustments like size, font,
color, etc.

5. Background tab
Colors and background images—are available in this area.

Click on the background tab, then select the color or
image you like
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6. Upload tab
Canva allows you to upload and use your own elements,
such as images and logos.
• Click “Upload your own images.”
• A window will open up, find the image you want to upload
and click open.

7. Delete uploaded image
You also have the option to delete the image you uploaded.
To do this:
• Hover over the image you want to delete and click on the “i”
icon on the bottom left of the image.
• Then click the “trash” icon

Save and download your design piece
Canva gives you the option to save and download your
design in four formats:
• JPG
• PNG (Recommended)
• PDF (Standard)
• PDF for print
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Share your design
Canva also gives you an option to share your design with
firends.

Social media: Share on your social media pages.
Link: Share the link to your design. 
Embed: Only available for public designs.

To share a design, click on the share button on the top right
corner of the Canva page. You will get a pop-up asking you
to specify how you would like to share.

Share by email:1.

2. Share on social media:
Click the arrow button on the top right of your screen and
select the social media platform you would like to share your
design on.
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3. Share the link to your design:
Copy and share the link to your design with other people. You
also have the option to allow other people to edit your work.

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/202
0/06/Canva-Userguide.pdf

According to the needs of the participants, you should
deepen only some functions of Canva, and just introduce
others.

Indications or
suggestions for the
trainers (if any) 

ICE - BREAKING ACTIVITY “I’M A ICT TOOL” 

Category 

Timeframe

Learning outcome

Practical

20 mins

This ice-breaking activity aims to make participants
understand each other's views on some of the project's
topics, while helping them get to know each other's
interests and values.

3 - Complex ICT Tools (Italy)

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
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Materials

Procedure

 Black board, post it, pens or markers

20 mins

Each participant is given post-its and a marker/pen.
The trainer launches a thematic input in line with the
project’s module. For example, he/she can ask
participants to describe themselves by comparing
himself/herself to a digital device/software/platform/
which is linked to the Complex ICT tool’s category
(Wordpress, SEO Language, etc.).

The participant writes the tool that represents him/her
on the post-it and then sticks it on the board. In
sticking it to the board, he/she gives a brief explanation
of why he/she believes he or she resembles that device
or ICT Tool. In this way, some participants may find that
they describe themselves in the same way, having
therefore things, characteristics, interests in common.

The idea behind this icebreaker is, indeed, to break
down initial barriers and strengthen the relationships
among participants. In addition, it could be a useful
activity to understand the relation that participants
have with platforms and technologies.

 The trainer could keep post-its and take notes on how
participants describe themselves for later activities. 

At the end of the activity the trainer will form 3/4 different
groups based on the choices made by the participants: ICT
tools similar go together (social media manager tools
together, writing and organization ICT tools together, creative
ICT tools such as Canva together, photography and video
tools together, etc.). This will be functional to the next activity. 
 

Indications or
suggestions for the
trainers (if any) 

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
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TEAM BUILDING ACTIVITY “DESERT ISLAND” 

Category 

Timeframe

Learning outcome

Materials

Procedure

Team Building 

35 mins

This game focuses on the improvement of
communication and negotiation skills. Through this
activity, the participants will be able to show their
knowledge of the digital issues and, at the same time,
improve the team spirit.

Black Board, Pencil, Post-it, Markers

Based on different groups formed on the previous
activity, participants will take part to a survival game. 
The trainer will introduce the background story: the
plane crashed on a desert island, from whose impact
each team managed to save, nonetheless, a laptop, on
which are present the main ICT tools. 
Setting a timer of 10 minutes, trainer will ask each team
to choose 4 ICT tools/skills/competences (that have no
obvious utility in this situation), among a standard set
of 10 different provided by the trainer, that they think
would be most useful in their survival. When the time is
up, have each team explain in 2/3 minutes why they
chose those tools and how they intend to use them. 

The 10 different ICT tools/skills/competences provided
might be:
1.Social network managing skills
2.Awareness of the most recent world’s trend thanks to
the knowledge of Google Analytics
3.Mastering of the writing program Word 
4.Ability in daily schedule by using Excel
5.Ability in easily find information while surfing the web
6.Being able to produce effective presentation using
PowerPoint
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Procedure 7.Creative skills by an extensive use of Canva
8.Knowledge of image branding by using WordPress
9.Skills in effectively delivering distance learning 
10. Creativity from the use of gamification at work 

At the end, the trainer may want to end the activity right
there, deciding therefore to give to the game a specific focus
on intra-teams' relationship strengthening up, or finalize it by
the whole participants group finding an agreement in
identifying all together the best 4 final ones, opting
consequently, as the output of the game, for an inside-the-
whole-group team spirit building.

Indications or
suggestions for the
trainers (if any) 

WORKSHOP ACTIVITY - "COMPLEX ICT TOOLS: HOW TO
INTEGRATE THEM INTO THE LEARNING PROCESS AND IN THE
EDUCATION SYSTEM"

Category 

Timeframe

Learning outcome

Materials

Procedure

Workshop

To think about benefits and possible difficulties of using
digital devices in the learning process. This leads to
reflect on the best way to introduce technology into the
teaching method.

60 minutes (20 minutes desk research + 20 minutes
presentation + 20 minutes final discussion) 

Black Board, Pencil, Sheets of paper, Markers

In continuity with the previous exercise, the same
groups will have to conduct a desk research on the 4
ICT tools’ set chosen in the Desert Island activity by one
of the other groups. Therefore, each group will have to
do desk research on ICT tools they hadn’t work on
previously. 

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
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Each group will have 20 minutes to identify the benefits
of using the assigned digital tools, together with the
most functional ways of integrating those tools into the
educational context. 

How to implement them? 
What are they so functional for? 
What could be the difficulties in using them?

The second phase of the workshop each group will
present the results obtained in 5 minutes per group, for
a total of 20/25 minutes. 

During the third phase, the trainer will facilitate a final
debate in which the participants will be able to discuss
their experiences in the use and fruition of digital tools.
He will stimulate discussion with questions such as:
1. Have you ever used for school’s tasks one of the
complex ICT tools mentioned?
2. How to improve the use of these technology at
school?
3. Do you think there are any problematic aspect to
take into account?
4. How would using this tool change your current
practice?

Indications or
suggestions for the
trainers (if any) 
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ICE - BREAKING ACTIVITY “TYPICAL SNACKS” 

Category 

Timeframe

Learning outcome

Materials

Procedure 

Practical

20 mins

The aim of the activity is to get the participants to know
each other both personally and professionally. It is also
very important to emphasize that everyone should
know each other's expectations and aspirations.

Plates, gummies, notepads, pens

This method is used to better understand the emotional
state and character of the participant.

A plate with unusually shaped gummies is placed on
each table. Participants are asked to place one or two
treats on their plate and carefully examine their shape,
texture, taste, etc. Then each participant writes down
8-10 adjectives describing the chosen candy. When
everyone has done this, each person chooses one of
the words written down that best describes him/herself.
Then everyone takes turns telling the group the
adjective they have chosen explaining why.

ADVANCED
4 - Developing Digital Content (Lithuania)

Indications or
suggestions for the
trainers (if any) 
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TEAM BUILDING ACTIVITY “BLIND ALPHABET” 

Category 

Timeframe

Learning outcome

Materials

Procedure

Practical

20 mins

The aim of the activity is to motivate teamwork and
recognize leaders. In this exercise. In this exercise,
participants develop the ability to connect and
cooperate with a group in difficult conditions. The
following key points emerge: group work in difficult
conditions, communication and dynamics of group
leaders.

Scarves, a rope

Group members are blindfolded and hold the rope with
both hands. The leader tells the group the letter or
figure that the group members must create using the
rope. They need to decide for themselves when the task
is done. The exercise will be repeated several times,
showing different letters or figures to the group.

A suitable discussion after the task:
1. Was this task easy to complete? Why?
2. How did you overcome your blindness?
3. Who (what leaders) emerged during the task?
4. What did the assignment help you understand?

Indications or
suggestions for the
trainers (if any) 
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WORKSHOP ACTIVITY - "OFFICE365"

Category 

Timeframe

Learning outcome

Materials

Procedure

Workshop

Participants will learn how to use Word, Excel and
PowerPoint online, learn how to share documents, find
them from other devices, and save them in the cloud.

3 hours

Internet, https://www.office.com – accounts 

Word

Create something
Begin with a Blank document to get right to work. Or
start with a template to save yourself time and steps.
Just select File > New, and then select or search for the
template you want

https://www.office.com/
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Access files anywhere
Need to work on the go and across different devices?
Click File > Account to sign in with your Microsoft
account and access your recently used files anywhere,
on any device, through seamless integration between
Office, OneDrive, OneDrive for Business, and SharePoint.

Find recent files
Whether you only work with files stored on your PC’s
local hard drive or you store files in multiple shared
locations, selecting File > Open takes you to your
recently used documents and any files that you may
have pinned to your list.
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Discover related options
When you select objects in your document, options
related to your selection will appear. For example,
selecting a table displays the Table Design and Layout
tabs, which offer additional options.

Get writing suggestions
With Editor, bring out your best writing. Editor helps you
bring out your best writing by giving you intelligent
writing suggestions. It also calculates an Editor Score
based on the number and types of suggestions you
have yet to address. Select an underlined word or
phrase to accept or ignore a suggestion.
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Review and track changes
Whether you just want to check spelling, keep your
word count in check, or fully collaborate with other
people, the Review tab has essential commands to
track, discuss, and manage all of the changes made to
your documents.

View who else is typing
Co-authoring Word documents that are shared on
OneDrive or on a SharePoint site happens in real-time,
which means you can easily view where other authors
are making changes in the same document that you’re
currently working in.
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Format with styles
Styles lets you create, apply, and review the formatting
styles in your current document. To open it, select the
Home tab, and then select the small arrow in the lower
right corner of the Styles gallery

Find whatever you need
Type a keyword or phrase into the Search box to quickly
find the Word features and ribbon commands you’re
looking for, to discover Help content, or to get more
information online.

Share your work with others
To invite others to view or edit your documents, select
the Share button in the top right corner of the app
window. Then, you can choose to share a link to your
document or send invitations directly to specific
people. If someone doesn't have Word, they can use the
free Word for the Web app to edit and comment.
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Excel

Create something
Select File > New, and then select or search for the
template you want. Begin with a Blank workbook to get
right to work. Or save yourself time by selecting and
then customizing a template that resembles what you
need.
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Stay connected
Need to work on the go and across different devices?
Select File > Account to sign in and access your
recently used files anywhere, on any device, through
seamless integration between Office, OneDrive, and
SharePoint.

Find recent files
Whether you only work with files stored on your PC’s
local hard drive or you roam across various cloud
services, selecting File > Open takes you to your recently
used workbooks and any files that you may have pinned
to your list.
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Import data from anywhere
You can import data into Excel from a wide variety of
data sources.
Select Data > Get Data and choose where you would
like to import data from.

Share your work with others
To invite others to view or edit your workbooks, select
the Share button in the top right corner. Then, you can
share a link or send invitations directly to specific
people. If someone doesn't have Excel, they can use the
free Excel for the Web app to edit and comment.
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Manage data with Excel tables
You can choose to format any range of cells in your
current workbook as an Excel table letting you analyze
and manage a group of related data independently
from the other rows and columns in your workbook.

Insert functions
On the Formulas tab, select Insert Function to search
for and insert functions, look up the correct syntax, and
even get in-depth Help about how your selected
functions work.



245

Caculate with a click
Do quick math like Average, Sum, and more in a single
step with AutoSum. From the Home tab, simply select
cells with numbers and choose how you’d like to
calculate them.

Find whatever you need
Type a keyword or phrase into the Search box to quickly
find the Excel features and commands you’re looking
for, to discover Help content, or to get more information
online.
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Ask questions about your data
With Analyze Data, Excel empowers you to understand
your data through natural language queries that allow
you to ask questions about your data without having to
write complicated formulas.
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Powerpoint

Create something
Begin with a Blank Presentation to get right to work. Or
save yourself time by selecting a theme or template
that resembles what you need. Select File > New, and
then select or search for the theme or template you
want.

Stay connected
Need to work on the go and across different devices?
Select File > Account to sign in and access your
recently used files anywhere, on any device, through
seamless integration between Office, OneDrive, and
SharePoint.
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Find recent files
Whether you only work with files stored on your PC’s
local hard drive or you roam across various cloud
services, selecting File > Open takes you to your
recently used documents and any files that you may
have pinned to your list.

Share your work with others
To invite others to view or edit your presentations in the
cloud, select the Share button in the top right corner of
the app window. In the Share pane that opens, you can
get a sharing link or send invitations to the people you
select.
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Your personal designer
If you’re a Microsoft 365 subscriber, let PowerPoint
create great-looking slides for you based on the
content you’ve added. Select Design > Design Ideas
and then select your preferred layout in the Design
Ideas task pane. Designer detects pictures, charts, or
tables on a slide and gives you several suggestions to
pick.

Add captions or subtitles
Transcribe your words as you present and display them
on-screen as captions in the same language you are
speaking, or as subtitles translated to another
language. On the Slide Show ribbon tab, select Subtitle
Settings to see languages you can use.
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Add visual effects
Animation and transitions can help make a PowerPoint
presentation more dynamic. Select the Transitions tab
and select a type. On the Animations tab, select an
effect from the gallery. Select the More arrow to see
more options. To see what they look like when
completed, select Preview. If you want to customize the
effect, select the Effect Options button on the tab.

Format shapes with precision
Precisely format a selected picture, shape, icon, or
object with the comprehensive tools available in the
Format Shape task pane. To display it, right-click the
picture, shape, or object, and select Format Shape.
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Find whatever you need
Type a keyword or phrase into the Search box on the
ribbon to quickly find the PowerPoint features and
commands you’re looking for, to discover Help content,
or to get more information online.

Record videos with ease
Record your PowerPoint presentation. or just a single
slide. Capture voice, ink gestures, and your video
presence straight from within PowerPoint. Just select
the Record button to start.
You can play it for your audience in Slide Show or you
can export it as a video file.
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file:///C:/Users/vidba/Downloads/Word%20QS%20(2).pdf

file:///C:/Users/vidba/Downloads/Excel%20QS%20(2).pdf

file:///C:/Users/vidba/Downloads/PowerPoint%20QS%20(1).pdf

During the training, pay the most attention to one of these
programs (according to the needs of the group), and
introduce the others a little.

Indications or
suggestions for the
trainers (if any) 

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
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ICE - BREAKING ACTIVITY

Category 

Timeframe

Learning outcome

Materials

Procedure 

 Ice-breaking

30 mins

This initial energising activity has the aim of conveying
the role of of community, to build a "network" of
connection between people and encouraging initiative

A ball of string

Throw the skein like a ball from one person to another
in the circle, as you choose. Everyone must hold the
thread in their hand after the ball leaves their place.
The ball must reach everyone and everyone must hold
the thread in their hands. After everyone will be thus in
a tight "network", start throwing again following the
same path, multiplying and consolidating the network.
After you have done that, you can use this pose by
doing various movements, exercises accompanied by
reflections. Encourage the others to make reflections as
well.
Examples of reflections:
-   Shake each one, one by one, from the threads you
hold in your hand and wait for someone to answer you
in the same way. Did everyone get an answer?
-   Weaken the bonds. The network is weak if the links
are weak.
-    Stretch the strings. Facilitates communication.
-   What happens if someone lets go of the string? The
voltage drop is equivalent to a gap, the lack of feed-
back. Communication failure without response...

5 - Integrating and Re-Elaborating 
Digital Content (Romania)
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- Make a parallel with a community, a group,
emphasize the importance of links, feed-back in a
community for its success. Ask them for examples.
-   Help them to realise that they need to improve their
communication in the group and in other groups they
belong to, family, friends, a project. So that they can
rely on each other and not have problems when they
need each other.

Be creative and encourage them to be creative too!

What other movements can be done? (in the position you
are in). What do they mean? Give them a meaning in the
context of communication, community

Indications or
suggestions for the
trainers (if any) 

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
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TEAM BUILDING ACTIVITY

Category 

Timeframe

Learning outcome

Materials

Procedure

Team Building

90 minutes

Knowing and understanding the main ways of
transmitting and integrating digital content in the
learning process;

Development of practical skills for integration and re-
elaboration of digital content;

Strengthening team spirit and social communication
skills;

Wheel of Fortune (Annex 1), pen/pencil, laptops, video
projector

The activity involves a trainer and 20 trainees (teachers
of various specialties).
First part – Wheel of Fortune (30 minutes)
A wheel of fortune (a cardboard floor that will include
various applications) will be placed on the wall, and an
arrow will be installed on the right side. Each participant
will spin the wheel, and when it stops the participant
must present the application next to the arrow. If it
doesn't know it, it will spin the wheel again until it gets to
an app it does know. After its presentation, the
application will be removed or cut. It will continue with
the other participants, until the applications known to the
participants are exhausted.

Second part – team task (60 minutes)
The participants are divided into four groups. Each group had
a requirement to solve: the creation of a digital content with
the main theme of The importance of digitization in
education.
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Each group will use an application to create digital
content: group 1-Youtube; group 2-Prezi; group 3-
Mentimeter; group 4-Canva.
Each group will have 40 minutes to create the digital
content;
Each group will present the results to the others, in no
more than 5 minutes.

For both Wheel of Fortune and the team task, any other
applications can be chosen.

Indications or
suggestions for the
trainers (if any) 

WORKSHOP ACTIVITY

Category 

Timeframe

Learning outcome

Materials

Procedure

Workshop

Developing skills to integrate and re-elaborate digital
content in a blog and through the Nearpod app

4 hours

Laptops, Internet connection

Part one - Integrating digital content into a blog 
(2 hours)

About WIX

Wix is an online creation platform that makes it easy
and intuitive to build your own website. Here’s how:

Wix’s smooth drag and drop technology means you
can design the site you want without having to write
a single line of code.
Wix handles web hosting and SSL certificates, which
makes it simple to get your site up and running.

https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf
https://d31kydh6n6r5j5.cloudfront.net/uploads/sites/158/2020/06/Canva-Userguide.pdf


257

Wix has advanced features but is user-friendly even
for those with no prior knowledge of web creation.
Wix gives you the option to build from scratch or you
can answer a few simple questions and let Wix’s AI
create a custom website for you.
Wix offers a diverse range of website templates that
are strategically researched and tailored by
industry so you can get your business or
professional website online quickly.
Each page element has customization options that
appear at the click of a button.
Whether you’re in the Wix Editor or your site’s own
personal dashboard, the Wix Help button is always
close by.
Wix has a quick and simple signup process. Just
register with your email address, Facebook account
or Google credentials—and start right away for free.

How to make a blog using Wix 
Step - 1: Sign up and create a free account
Step - 2: Get a website made for you or pick a
template 
Step - 3: Make changes with the website editor
Step - 4: Add functionality with apps 
Step - 5: Choose a site design
Step - 6: Choose and connect a domain name 
Step - 7: Optimize and customize your website
Step - 8: Publish your website to make it live

Step – 1: Sign up and create a free account
To sign up, you need to follow three short steps:
To sign up, you need to follow three short steps:
➢ Go to Wix.com.
➢ Find the big “Sign Up” button and click on it.
➢ Enter your email address and choose a password.
Wix will not ask for credit card details or annoy you with
dozens of fields to fill up. It’s in their interest to provide
you with a fast sign up process, and you can literally be
done in under a minute.
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Step – 2: Get a website made for you or pick a template

Step – 3: Make changes with the website editor

Making changes with Wix ADI is possible, but the editor
is quite limiting. All you will get is the option of selecting
the elements and changing to a few predefined
options. On the other hand, modifying a template is fun,
and it allows you to be in charge of every part of your
website. You can create new pages and arrange them
on a menu that displays to your visitors. Whether you
decide to have a background color, add an image, or
even play a video, the options are all available to you.
No matter what kind of template you choose, you can
add dozens of elements and transform your entire blog
into a custom project.
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Click on Edit site

However, when it comes to blogging, the most
interesting settings are those that allow you to design
& manage your blog section. If you click on the
blogging section from the editor, you will be able to
control how the blog appears on your site. Show
featured posts only, hide author names, remove author
images, decide if you need the publishing date, reading
time, views counts, comments, or likes. You can even
handle layout changes with a single click. Don’t worry,
changing colors and paragraph styles is also possible,
as well as modifying borders, backgrounds, and the
feed. There are more than enough options for you to
play with, so the only limit is your imagination.
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Step – 4: Add functionality with apps
Although Wix comes with a plethora of options, there
are always users who will need more. If you’re one of
them, Wix App Market is for you. Simply search for
“blog,” and Wix will show you more than a dozen apps
you may want to install. These apps will introduce new
elements to your blog, so you can create a different
site altogether, add a search feature, different
commenting system, push notifications, social media
stream, and so on.

Step - 5: Choose a site design
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Step - 6: Choose and connect a domain name

When using a free account, Wix will let you use their
subdomain for free. That means you can have the
name of your blog displayed in front of Wix’s domain.
For example, you can have a domain like
myblog.wix.com, or actually anything.wix.com, as long
as the title is available (not used by anyone else on the
platform). This option is a fantastic feature you can use
for free while starting up, but as soon as your blog
starts generating an audience, you will want to connect
to a custom domain. To do this, you will need to start
paying for one of the premium plans and connect an
existing domain or purchase a new one. No matter
what you decide to do, Wix will guide you through each
step of the way, and you will be able to complete the
task without hiring experts.

Step – 7: Optimize and customize your website

Just a few years ago, blogs were something people
read exclusively from their desktop and laptop devices.
But today, your blog has to be available for mobile
users as well. With Wix, you can easily modify and
optimize your site for mobile visitors. If you’re in a rush
or simply not into editing the site in the minute detail,
click on the smartphone icon at the top of the screen,
and view the “Page Layout Optimizer”.
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When you click on the button, Wix will automatically
optimize your site for mobiles, and you will be good to
go. If you want more control over this, you can use the
menu from the screen’s left-hand side to modify
menus, pages, and background specifically for mobile
devices. These changes will not affect your desktop
version of the site.

Step - 8: Publish your website to make it live

Once you’re done modifying the site, and optimizing it
for mobile users and search engines, you should be
ready for publishing. This is the last step before the
entire world gets to see your blog. While you’re still in
the main editor, look at your browser’s top-right corner,
where you should see the big blue “Publish” button. 
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When you click on the button, Wix will automatically
optimize your site for mobiles, and you will be good to
go. If you want more control over this, you can use the
menu from the screen’s left-hand side to modify
menus, pages, and background specifically for mobile
devices. These changes will not affect your desktop
version of the site.

Click on it, and wait for a second. Wix will publish your
website, and show you a popup window with the
details.

Wix is an incredible free website builder that lets you
create any kind of site you can imagine. If it’s a blog
you want, it can be done in less than an hour. 
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However, before choosing Wix exclusively for blogging,
you should know that this platform is designed for
creating personal and business websites. Although
blogging is possible, it’s quite basic and only suitable
for people who don’t expect much.

Bibliography
https://www.wix.com/blog/2021/02/how-to-start-a-

blog/

https://www.wix.com/start/blog

https://www.youtube.com/watch?v=TEaMKxSQLmg

https://www.youtube.com/watch?v=AqYcBEaCVec

https://www.youtube.com/watch?v=esvR6Es3Uag

Part two - Integrating digital content into a blog (2

hours) 

About NEARPOD 

Nearpod helps educators make any lesson interactive

whether in the classroom or virtual. The concept is

simple. A teacher can create interactive presentations

that can contain Quizzes, Polls, Videos, Collaborate

Boards, and more. You can access thousands of

premade lessons or upload your existing lessons and

make them interactive using Nearpod in the classroom.

Nearpod makes teaching easier with the interactive

tools, resources, and content teachers need, all in one

place. 

The students can access a teacher’s Live Participation
presentation through a code and the teacher then
moves the class through the lesson and lets students
interact with the media as they go. 



265

Teachers can also opt for Student-Paced mode, where
the student controls the flow of the lesson. This mode is
perfect for remote learning, hybrid learning, sub days,
homework assignments, or independent work. The app
is web-based and works on any device with an internet
connection. 

1. Go to www.nearpod.com 
2. Click CREATE ACCOUNT 

3. Fill out the requested information and click SUBMIT

4. Sign in with e-mail address or user name and
password (or login with Google) - see item 2 above
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3. Upload a PDF or PowerPoint (one page = one slide in
landscape format), Keynote document needs to be
converted to a PDF (also supports images and zip files)
> Click START FROM SCRATCH (to create) or
 BROWSE MY FILES (to upload) 

4. Click the PENCIL next to UNTITLED Lesson to provide
information

CREATE 
1. Click CREATE - edit and publish your presentations  
(under My Lessons!) 

2. Click + Lesson to start a new lesson 
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5.Click in UNTITLED PRESENTATION box to provide the
presentation with a unique name, description is
optional ,select a language (English is default) > click
SAVE 

6. Title your lesson, add descriptive words, learning
standards information ,and select the grade and
subject.Adding this information is not required ,however
it will make it easier for you to find this lesson next
year.Press submit to save your lesson details

7. To edit beginning slide, click on the slide (blue border
around screen and check in left top appears
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8. Add Image, text, or audio from the EDIT menu

9. ADD a slide - click "+" > features include slide, slide
show, poll, open ended ques

Choose from the available Content choices or the
available activity choices.
For a complete list of Nearpod's media types and
formative assessments along with a how-to for each
feature

Interactive sequences



269

Or Quizzes & Games

10. TO CREATE A SLIDE (add text, images, and audio) >
click SAVE when done
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Explore all the creative options available for creating
interactive slides in Nearpod.Consider the layouts and
themes ,use the rich text editing options and add
additional media to show your creativity.
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Click "Save and new" to save the current slide and
create the next one. 
Click "Save" to save the current slide and return to the
lesson editing page.

The Nearpod Presentation is ALOT like PowerPoint with
adding slides and reordering them.
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11. TO ADD SLIDE SHOW (to add a PowerPoint - Keynote
must be converted to a PDF) - this is for a limited time in
free version -must upgrade to premium for continued use  
> SAVE 
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12. POLL (enter question and possible answers - use
ADD ANSWER to add more answer choices ) > SAVE 

13. OPEN ENDED QUESTION > Enter question  > click SAVE

14. To add a QUIZ - Enter title > enter question > enter
possible answers > click check mark next to correct
answer > continue with questions and answers until
quiz is completed > click SAVE
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You can also allow student to match notions in pairs:

15. To add a VIDEO - Add a short video from files or
Dropbox > click SAVE



15. To add a Interactive games , you can choose Time to
Climb, or Memory Tests of Fill in the blancs -
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Try a Time to Climb game and turn your quick activities
,exit tickets, and checks for understanding, into a
competitive game with instant student feedback. Time to
Climb is the perfect way to get started with Nearpod.

16. DRAW IT - upload a matching worksheet or other
document for students to draw on 

17. WEB PAGE - copy and paste web address of webpage -
this is for a limited time in free version -must

upgrade to premium for continued use > SAVE

18. FINISH PRESENTATION - Slides may be rearranged by
clicking and dragging it to desired location -When
presentation  is complete, click DONE > click YES to publish
(NO if still in revision stage )
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After editing your lesson details and completing your
lesson, click "Save & Exit" to save your lesson and return
to My Library. Or click "Preview" to see what your lesson
will look like from a student perspective

PRESENTING NEARPOD LESSON 

1. From the My Library page, Click on desired lesson

2. Control the pace of a lesson and let students participate on
their own devices with live participation 

Have student launch Nearpod app on Phone and provide
them with the code at top right. 
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At the end of the lesson you will get the report of
every student’s activity

(STUDENT VIEW --> Click NEARPOD --> Enter code into
STUDENT ENTER PIN (keyboard will appear when inside ))
the Pin Box is touched and click OK --> Presentation will

download and appear on student iPad --> Presentation is
controlled by the teacher
Top left of pin (green people) will show you the number of
students connected

 First slide after title slide will show the student list > click
right arrow key or slide to move to next slide
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Indications or
suggestions for the
trainers (if any) 

3. Personalize instruction for individual students, small
group assignments , or homework to differentiate and
allow students to work at their own pace choosing the
second option

4. You can also watch a video as a class and stop to
discuss key instructional moments using premade
questions without devices

5. Reduce lesson creation time with premade lessons
,videos, and activities. Search by standard for every grade
and subject for resources built in partnership with your
favorite brands. Easily customize to fit the needs of your
students.

Bibliography
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Learn how to use Nearpod, get advanced tips, and receive
support to get started any time of the year.
https://nearpod.com/resources

Join a Nearpod community to gain exclusive resources, support
for sharing Nearpod, and a network of educators transforming
teaching with technology. 
https://nearpod.com/communities

You can also edit and preview this lesson for study 
https://np1.nearpod.com/sharePresentation.php?
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ICE - BREAKING ACTIVITY  “TECHNOLOGY CHAIR DASH”

Category 

Timeframe

Learning outcome

Materials

Procedure 

Practical

30 mins

This ice-breaking activity gives participants the
opportunity to introduce themselves to each other and
learn what digital skills each participant has. 
Participants will learn about each other's level and
knowledge of digital skills, whilst also breaking down
barriers and strengthening the relationship amongst
participants.

Statements in a box

The Participants should sit in a circle.

Part 1 (10 mins)

1. Working in pairs, the participants will introduce
themselves to each other including their name and
an interesting fact about themselves.
2. As a group, each participant should introduce
themselves as if they are their partner. Introducing
them as their partner's name and telling their
interesting fact.

Part 2 (20 mins)

3. Select one participant to stand at the front of the
group, removing their chair from the circle.
4. The participant standing will pull a statement out of
the box and read this to the group.
5. Anyone that answers ‘yes’ or agrees to the
statement should stand up, and it becomes a game
of swapping chairs.

6. Integrating ICT and Digital Content into
Teaching (Finland)



6. The participants should then rush to switch
chairs in the quickest time, and again there will be
one participant left standing at the front that hasn’t
got a chair (like the game musical chairs). 

Points 4 to 6 should be continued until all questions
have been answered. 

Indications or
suggestions for the
trainers (if any) 

Trainers can print the questions below and add these
to the box, or participants can think of their own
questions if they wish.
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TEAM BUILDING ACTIVITY  “PERSONAL OPINIONS” 

Category 

Timeframe

Learning outcome

Materials

Procedure

Practical and group discussion

40 mins

This team building activity aims to get participants to
share their opinions on using technology and discuss
their views and experiences

Signs for “agree”, “neutral” and “disagree”. Paper
and pen for the trainer to take notes. 

Part 1 - practical (15 mins)

 Participants should be stood, and the signs should
be placed in three different areas in the room.
1.The trainer should read out the first
question/statement. Participants should move to the
correct sign so the group knows if each participant
agrees, disagrees or is neutral. This should be
individual opinions and participants should choose
their own response.
2. The trainer will ask a couple of participants to
explain why they have chosen the response they
have. 
The above two points will be carried out until all
questions/statements listed below have been
actioned.

 The level of student interaction increases when
digital means are used in the classroom.
 You have received adequate training on the
digital tools you use in the classroom. 
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 Using digital means in the classroom can have a
negative impact on the students 
 I rely on digital means for my job
 Students need to use technology and ICT in school
as the skills they learn will be vital when they leave
school and enter the working world
 Sharing digital skills, digital knowledge and digital
material with your colleagues is important.
Students do not need to be taught ICT skills as most
of them already have the knowledge.
Your students have more knowledge of digital
platforms and ICT than you. 
Your school has sufficient digital devices for
students. 
 Funding and budgets can be an issue when it comes
to digital learning and ICT.

Part 2 - discussion (25 mins) 

The participants will take part in a group discussion and
explain their feelings on using technology and digital
means in the classroom. 

The trainer will encourage participants to share/discuss,
but not limited to:

The digital means they use for teaching.
 Their opinions on technology in the classroom. 
 How technology can help in learning.
 How technology can help with student development. 
 The positive aspects of using digital means for
teaching. 
 The negative aspects of using digital means for
teaching.
The training they have received. 
 How comfortable they feel using technology and ICT. 
 How confident they are using new digital means. 
 Do they feel they receive relevant support and
training? 



Indications or
suggestions for
the trainers (if
any) 

The trainer should keep notes of the participants'
responses.
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Category 

Timeframe

Learning outcome

Materials

Procedure

Practical workshop

To learn how to make a basic Wordpress site and how
this can be incorporated into teaching

2.5 hours

IProjector/screen and laptop for trainer Laptop per
participant 

 What is WordPress (15 mins) 

The trainer will show this video  on ‘What is WordPress
Anyway’, followed by a group discussion on what the
participants understand about WordPress, and they
will discuss if they have used the platform before, if
they know what it is, their skill level and how they feel
about using WordPress.

WordPress examples (5 mins) The trainer will then
show the participants a selection of WordPress sites,
showing a mix of basic sites, to how advanced
WordPress sites can be.

Example 1 -  https://tropicalastral.com/ 
Example 2 -  https://www.eginstill.com/
Example 3 -  https://www.fubiz.net/

Create a basic WordPress site (1.5 hours) 

The trainer will show the finished version of the website
the participants will create. The website they will
create has been designed for teachers to share
teaching material with each other, such as
downloadable flashcards and links to educational
videos. 

WORKSHOP 
"INTEGRATING ICT AND DIGITAL CONTENT IN TO TEACHING"

https://www.youtube.com/watch?v=cT4NlI00hMw
https://www.youtube.com/watch?v=cT4NlI00hMw
https://tropicalastral.com/
https://tropicalastral.com/
https://www.eginstill.com/
https://www.eginstill.com/
https://www.fubiz.net/
https://www.fubiz.net/
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The participants should download the materials they
need to create their website from this link. 

The trainer will run through each section with the
participants, following the screenshots and instructions
below, and they will create their own website as the
trainer talks through each section.
 Sections include:
1. Create header 
2. Create banner 
3. Design homepage 
4. Create menu
5. Create page with downloadable material 

Once the participants have completed the task, the
trainer will give them the opportunity to ask any
questions, or if there is anything specific that they wish
the trainer to show them.

Present website (10 mins)

Each participant will present their website to the group. 

Group discussion and evaluation (30 mins) 

The trainer and participants will take part in a group
discussion and talk about how they found the
workshop, including challenges, how easy/difficult they
found the tasks, how useful they feel this would be for
teachers etc. 

The participants will complete an evaluation form
providing feedback on the training format.

Indications or
suggestions for
the trainers (if
any)

The trainer should talk through all the stages. The
trainer can provide the participants with the handout
found below if they feel this will be useful, otherwise
the trainer can just talk through the steps
The timings of the workshop are suggested based on
the participants having a mix of technical skill levels.
The timings may vary depending on skill level.
Ahead of the training, the trainer should ensure a
sample site is set up for each participant.

https://drive.google.com/file/d/1fmx8nmpLEmiBPdSYR7kK5r2EG9AHcAaW/view?usp=share_link
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Below is the screen you will see when logging in to WordPress

This has already been set up ahead of the training, but to change the theme
of the site, click appearance’ and you can change the theme of the website

Workshop handout 
Integrating ICT and Digital content into teaching
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For the purposes of this training, the ‘Neve’ theme will be used 

Select the option to 'customise' under appearance
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You will then see what your website currently looks like. 

We will now set a header, this header will be seen across all pages on the
website. 

Select ‘header main’
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Then choose ‘style’

Scroll down and select ‘image’
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Select an image to upload, the trainer will provide the participants with a
selection of pre-made images they can use for the banner

Click ‘select files’ 
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Upload the image you wish to use for you website banner from your
device

Select the image, and click ‘select’
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Your banner will then show how it will look on your website

Change the size of the banner by moving the ‘how height’ slider

You will also need to select ‘mobile’ to change how this would look on a
mobile device
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You will also need to select ‘mobile’ to change how this would look on a
mobile device

You can delete the text box where your name is shown, and also the text
box where ‘Sample Page’ is written
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Click the ‘x’ on ‘Primary Menu’ to remove the ‘Sample Page’ text box 

You can then customise the colours on your website
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Click on each colour box and choose the colours you want for your site. 

You can also do the same for the ‘typography’ 
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To save the changes to your site, click ‘publish’ 

Now to make the footer. Click ‘footer’
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Click ‘footer bottom'

Choose the ‘columns layout’
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Click the blue bar 

Select ‘footer one’
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Click on the ‘+’ button

Click and drag the ‘paragraph’ option to the box that says 'footer one'

You can then type what you want to appear on this part of the footer. You
can see the layout and how this will look as you type
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You can then type what you want to appear on this part of the footer.
You can see the layout and how this will look as you type

Then click on the top footer box and add footer 2 to the box highlighted
in yellow below
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Continue to add footer 3 and 4, as highlighted in yellow below 

Continue to add content to footer 2, 3 and 4 , following the same steps
as you did for footer 1

The header and footer for your website are now complete. Click ‘publish’
to save all changes
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Go back to the dashboard by clicking the ‘x’ 

When you have returned to the dashboard, create the home page for
your website. Click on ‘pages’ on the menu, then click add new. 
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Choose and type a suitable name for your website, then select ‘publish’

To start designing the home page, select ‘edit with elementor’. Note –
anytime you edit a page, ensure you select 'edit with elementor' and 'not
edit page'
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Select the ‘+’ button to add a new section to the page

Select how many columns you wish to have in this section. For this
exercise we will select one
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On the left, click and hold spacer,and drag it to the new section

The spacer will then show
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You can change the height of your spacer

Follow the same process to add the download image and text, this time
selecting two columns
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To add an image, select ‘choose image’

Click ‘upload files’, then select your file 
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Select the image you wish to upload from the ‘download image’ file

Ensure the image is selected and click ‘insert media’
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The image will then show on your webpage. You can change this to
whatever size you wish

Go through the same process and insert a text box 
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Enter your own text, typing in to the box on the left hand side under 'edit
text editor'

Add a heading 
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Type text in to your heading 

To move the heading to the top of the page, click and drag the button
with six dots
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Your page should then look like this. Add a spacer below the text to add
space between the pages content and the footer. When you are happy
with your homepage, select ‘update’ to save changes 

We now need to set this page as the homepage. Go to the dashboard
and select ‘settings' then 'reading'
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Ensure ‘a static page (see below)' is selected , ad choose the name of
the page you wish to set as your homepage

Click on ‘save changes’ 
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Repeat the earlier stages to create a second page and call it
‘downloadable material’

Edit the page with Elementor and try to create something similar to the
below. With two images showing the flashcards, with text to download
in PDF 
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To add the link to download the PDF, follow these steps. Go to the
dashboard, select ‘media’ then ‘add new’ 

Click on the file once it has uploaded 
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Select and copy the ‘file URL’

Select the text box, click the link button,and paste the file URL.
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Change the settings so the PDF opens in a new tab

Repeat the process for both PDFs. Make your page your own, by adding
spacers, headings etc. Have a go at adding a YouTube video, changing
this so it auto plays, plays on mobile and loops. Here is an example of
how the page will look 
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The final stage is to add your ‘downloadable material’ page to the
website menu. On the dashboard go to ‘appearance’ and ‘menus’

Give your menu a name and tick the 'primary menu' box
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Tick the box of the page(s) you wish to add, then select ‘add to menu’

A button for the home page will not automatically appear on the
menu.To add this ,click on ‘custom link’ and add the home page URL
and the text you wish to appear for the home page. Select ‘save menu’ 
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Click on the ‘manage locations' tab under ‘primary menu’ choose the
menu you wish to add

You will notice that the menu hasn’t yet appeared on your website. To
make this visable, select ‘appearance’ then ‘customise’. Choose
‘header’ then ‘top header’ 



Click in the empty space and select ‘primary menu’ 

You can then change the colours etc of your menu, selecting ‘publish’
when you have made all your changes

- End of workshop –
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ICE - BREAKING ACTIVITY  “THE CHAOTIC JUGGLING MACHINE”

Category 

Timeframe

Learning outcome

Materials

Procedure 

ICE Breaker

20-30 Mins

Teambuilding, icebreaking, remembering the names of
the people in the group, brain stimulation, improving
hand-eye coordination and reflex, increasing the
energy level. 

Materials: juggling balls (or other balls suited to the
palm size of the players, easy to throw and catch with
one hand)
- As many balls as players
- Preferably the balls in different colours 

Instructions:

 The warm up phase:

Players standing in a circle, facing the middle 
One player (the facilitator) holds one ball and has a
bag or a basket with the rest of the balls in front of
them
The facilitator says the name of another person in
the circle and throws the ball towards this person
The next person says the name of another person in
the circle and throws the ball towards that person,
and so on 
It’s important to remember the name of the person
that you throw to!
After throwing the ball to someone else the player
crosses their arms on the chest
Players keep saying names and passing the ball
between each other (every time crossing their arms
on the chest after having thrown the ball to another
person)

EXPERT
7 - VR Literacy and Features
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You cannot throw the ball to a person with their
arms crossed on the chest 
The last person without their arms crossed throws
the ball to the facilitator
→ The game phase:
Similarly, as in the warm up phase, the players will
keep passing the balls between each other 
During the game players don’t cross their arms on
the chest
Every one should always pass the ball to the same
person as in the preparation phase 

First round:
- The facilitator starts the game by passing the ball to
the second person 
- The second person passes the ball to the third person,
and so on
- When the ball gets back to the facilitator, they ask the
group if they think they would manage to have two
balls being passed around at  the same time
- In the following rounds each player can have
maximum one ball in their hands at a time (you
shouldn’t pass a ball to a person who has another ball
in their hands at the moment)
- If a player receives a ball when they already had one
ball in their hands and they end up with two balls in
their hands, they show the two balls to the previous
person in the sequence, and the person that passed
the second ball too early has to do a squat as a
“punishment”
- You cannot pass a ball to a person which is doing a
squat at the moment

Second round: 
- The facilitator starts the game by passing the first
ball to the second person, just like before
- While the first ball is being passed around, the
facilitator introduces the second ball into the game by
passing it to the second person, so two balls are being
passed around at the same time 
- When the first ball gets back to the facilitator they put
it down, the same with the second ball 
- The facilitator asks the group if they think they would
manage to have three or more balls being passed
around at the same time

  Third round: 
- The facilitator starts the game by passing the first
ball to the second person, just like before



- While the first ball is being passed around, the
facilitator introduces a second ball into the game by
passing it to the second person, and after a third ball,
so three balls are being passed around at the same
time 
- The facilitator keeps adding the balls until the group
manages to pass the balls around 
- At any moment the group can have a discussion on
the strategy and the specific things they could improve

Fourth round: 
- The facilitator presents the special ball (it has to be
easy to distinguish it from the regular balls, for example
by the colour) 
- When the special ball will appear in the game,
instead of throwing it like all the other balls you have to
roll it on the ground (you can also invent a different
rule for the special ball) 
- Like in the third round, the facilitator starts the game
and keeps adding more balls
- The facilitator introduces the special ball at any time
that they want
- The ultimate challenge of the game is to reach the
number of balls being passed at the same time which
will be equal to the number of the players minus one
(for example 15 balls if there are 16 players including
the facilitator)

None.

TEAM BUILDING ACTIVITY “TOGETHER WE REACH FUTHER ”

Category 

Timeframe

Learning outcome

Materials

Team Building Activity

60 mins

Developing trust and reliance on team members.
working together in a hand-to-hand atmosphere
Build a stronger team spirit and cooperation

Bibs, footballs, small balls. 
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Indications or
suggestions for the
trainers (if any) 



The Trainer will divide the participants in two or four
teams. Each team has its own “base” in one of the two
sides or four corners of the square field. In the middle of
the field, the Trainer will spread coloured small balls
inside a hoop.
The Trainer will explain the purpose of the game and
the rules:

For each round, each group should choose one member
to take the challenge set by the Trainer. The rest of the
team is supporting and cheering their teammate in
order to complete the challenge.

Challenge one: One representative per team will
walk/run to the middle of the field and pick only one
ball at the time from the hoop trying to gather as many
as balls as possible.
 
Challenge two: One representative per team will go
side walking to the middle of the field and pick only one
ball at the time from the hoop trying to try to gather as
many as balls as possible.

Challenge three: One representative per team will start
from a sitting position and walk/run to the middle of the
field, sit down and pick only one ball at the time from
the hoop trying to try to gather as many as balls as
possible.

Strategy moment: the Trainer will give 5 minutes to the
teams in order to develop a strategy before the third
round (5 min). Third round: participants will play with
the rules of challenge two, putting into practice the
strategy they decided in step 6 (15 min). 

Variation:
The Trainer can adapt variations according to the level
of the group.

All members of the team take turns in the challenges
Each team can have a colour assigned. In this case,
team representatives will have to pick only the balls
of the colour of the team. If they pick up a ball of the
wrong colour, they will have to go back to their team
area and then try again.
Team members can be blindfolded for one round.
Instead of the colour, the Trainer can use balls of
different materials/textures.

Procedure
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The trainer should always introduce the easiest version
of the activity first and then can move on to the
different variations according to the level of the
participants.
During the workshops, the trainer always needs to be
supportive and ready for intervention in case of an
emergency.
Specific attention should be given to the
debriefing/evaluation at the end of each workshop.

At the end of the session the Trainer will have a
debriefing with all the participants to receive their
feedback regarding the workshops.
 
Debriefing: 
The Trainer will engage the participants in a debriefing
session, using visual material with pictures, emojis etc.
(10-15 min). 

Questions: 
How did you feel in this workshop? 
For the members doing the challenges: did you feel
supported by your team? 
For the teams: did you feel frustrated during the
challenges? Do you think that you were capable of
supporting your team member?
How did you choose the member that should do the
challenge? 
How did you come up with a strategy? 

WORKSHOP ACTIVITY “A VIRTUAL FUTURE”

Category 

Timeframe

Learning outcome

Expert Workshop 

Identifying the Virtual reality and augmented reality 
Raising awareness about the applications and
implementations of VR within different contexts
Gather information from different participating
countries about their participation in
implementation and improvement

40-70 mins
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Indications
or

suggestions
for the

trainers (if
any)

Part one 

In this activity, the learners will first reflect on the
following questions individually and then discuss in the
group: Think about your daily life and work context: 

Which of these hardware systems are new to you?
Which have you never used?
 In an ideal setting, which of these systems would
you wish to use in your work (bearing in mind the
specific learning outcomes you want to achieve)? 
 Which of these hardware systems do you use on a
daily basis (both private and personal life)? In what
ways do you use them? Are there any functions
these systems have that you do not actively use?

Part two

Form groups of a minimum of 3 people (minimum
requirement of two groups). Within your group think of
a typical situation within your company where you
need to connect various devices, or think of a learning
situation where that might be necessary. Then, choose
at least three devices you can connect on the spot to
form a Digital learning technology hardware system of
devices (one device per learner EX: Phones) and decide
on a file/media to transfer between the devices (video,
image, PDF, etc.). Think of the compatibility and
interconnectivity issues that might arise and discuss
them within your group. Prepare short instructions,
based on which another person should be able to
effectively connect all devices into a setup. Now, swap
setups between groups (group 1 receives at least three
devices from group 2, and group 2 instructs group 1 on
how to connect them in a setup and vice-versa).
Discuss the experience within and between groups. 

Procedure

Materials Flip charts, markers, internet and phones
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Materials

Procedure 

MEach participant prepares, in the form of 2 images
(photo, screen copy...), his/her representation of virtual
reality. Participants should choose images referring to
a positive and negative representation of virtual reality. 

From a bank of images of their choice, the
participants have 5 minutes to prepare two pictures
that most evoke VR.
They deposit the 2 pictures on a collaborative
slideshow:

[https://docs.google.com/presentation/d/1e38kIm5lNtki
EC BFWKg4Cv7meZ6Z7rZi/edit#slide=id.p1]

Participants drag parts from the side of their slide or
insert their own [Insert, Image, Search]. 
They can also copy and paste parts from slides #3-
7 to create their representation of VR. 
In the textbox, they write about themselves. 
Then they explain their choice and tag it according
to the criteria: positive or negative.

The debriefing consists in a confrontation of choices
and their explanations. If possible, there will be a
synthesis of the activity proposed by tags on
collaborative slideshow.

ICE BREAKING ACTIVITY “MY REPRESENTATION OF VR” 
ICE BREAKING ACTIVITY “MY REPRESENTATION OF VR” 

Category 

Timeframe

Learning outcome

Active methods of choosing and explaining
representative features of pictures about Virtual Reality 

15 - 20 minutes 

Working on one’s representations of the Virtual Reality
by:

Discrimination 
Introspection 
Explication

8 - VR Content Development
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Learning outcomes

Materials

The aim of this activity is to develop team problem
solving skills. It has positive impact on team
creativity, communication as well as group decision
making.
Strengthening good collaboration in a team with
positive energy. 
Building argumentation and reasoning skills. 
Presenting opinions as logically as possible.
Viewing differences of opinion as both natural and
helpful rather than as a hindrance. 

Procedure

List of items printed
Notebook
Pen/pencil
Laptops
Video projector

The activity involves a trainer and 20 trainees (teachers
of
various specialities). The activity consists of two parts.

Part 1 (10 minutes): Without communicating with the
team members, each team member has to prepare their
answers individually by ranking each item in order of
importance and explain the reasoning. Each member
has to place by number one the most important item,
number two by second most important item and so on
until number fifteen which should be the least important
item. 

Part 2 (30 minutes): Then, split the participants into
teams. Each team has to reach a common conclusion
through discussion and argumentation, not through
voting or statistical calculations. Each group must arrive
at consensus.

Instructions to the trainer

Together with the group read the scenario: 

ICE BREAKING ACTIVITY “MY REPRESENTATION OF VR” 
TEAM BUILDING ACTIVITY “THE MOON SURVIVAL”

Category 

Timeframe

Practical activity (online or in-class activity). The
activity can be also used as an energizer

40 minutes
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You are part of the spaceship crew heading for the moon.
Your original mission was to land near your mother ship
on the moon’s surface and join the team there, but you
experience severe mechanical problems which forced you
to land about two hundred kilometers from the mother
ship. Your ship and many of your supplies were damaged
in the landing, so it’s up to you and your team to decide
what to bring with you as you attempt to make the
journey on foot.

These are the items from your ship that are at your
disposal:
1. A box of matches
2. Food concentrate
3. 50 feet of nylon rope
4. Parachute silk 
5. Portable heating unit
6. Two .45 calibre pistols 
7. 1 case dehydrated Pet milk 
8. 2 hundred-pound tanks of oxygen 
9. Stellar map (of the moon’s constellation) 
10. Life raft 
11. Magnetic compass 
12. 5 gallons of water 
13. Signal flares 
14. First aid kit containing injection needles 
15. Solar-powered FM receiver transmitter

After reading the scenario and the list of items, order
them from the least to the most important for survival.
Allow yourself time for individual ranking (about 10
minutes).

After that, start the decision – making process as a group.
Agree on a time limit for group decision (about 30
minutes). After you make the group decision, read the
reasoning from the NASA experts here: 
Microsoft Word - MoonExercise.doc (csuchico.edu)
You can compare your individual scoring and group
scoring with NASA scoring to see how well you did.

Indications or
suggestions for the
trainers (if any)

2134

Discussion at the end of the session
After revealing the correct answers and allowing teams
to calculate their scores, record the team score and the
lowest individual score from each team. Then ask the
teams to think of the following questions: 

https://www.csuchico.edu/anthmuseum/_assets/documents/nasa-exercise-survival-on-the-moon.pdf
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WORKSHOP “VR CONTENT DEVELOPMENT”

Category 

Timeframe

Learning outcome

Materials

Procedure

Practical Workshop 

To learn different applications of VR content in the
classroom 
To learn how to develop simple VR content in Unity 

3 hours

Projector/screen and laptop for trainer 
Laptop per participant 

Activity 1: Thought for Food (1 hour)

Participants are invited to navigate Seymour & Lerhn
Immersive
Classroom
(https://www.seymourlerhn.com/schools/demo-
classroom ) to get an idea on how VR content works in
the classroom.
The trainer splits participants into three groups. Each
group shall reflect and brainstrom on VR content
development by developing a Mind Map
(https://www.mindmaps.app).The trainer provides a list
of questions to be considered. 
1. Present examples of VR applications in the classroom.
2. Which are the benefits of using VR in your lessons?
3. What would you need to start developing VR content
in terms of hardware and software? 

How did your individual choices differ from your
group choices? 
How were you able to persuade your team members
about your opinions? 
How would you evaluate your team communication? 
How effective was your group decision-making
process? 
What are the main take-aways from this activity for
your team problem solving activity?

https://www.seymourlerhn.com/schools/demo-classroom
https://www.seymourlerhn.com/schools/demo-classroom
https://www.mindmaps.app/


4. What could consist of VR content?
5. What are the technical requirements for creating VR
content? 6. Are you aware of different ways or tools to
create VR content quickly and easily? 

At the end of the brainstroming activity, each group
takes a turn explaining to all participants their ideas
already captured in the Mind map. 
At the end of group’s presentations, the trainer shall run
a debriefing session summarizing the main learning
points from the session, from the group insights and
explains how these learning points can be incorporated
into the following activities.

Activity 2: 
Animate 3D scans of real object as a base for VR
content (30 minutes)

Participants work again into three groups
 Each group should scan an object they will select
with the device camera (tablet or mobile phone).
Upload the scanned photo to a specific software
platform that processes the image, such as
Matterport, Entiti Creation, YouVisit.
Receive a 3D copy based on the media from that
platform. 

Activity 3: Introducing Unity for VR Content
Development (1,5 hours)

The trainer will present to the participants a selection of
VR contents developed with the software Unity.

Examples of projects created in Unity: 
https://unity.com/demos 
Then the trainer provides downloadable materials 
https://docs.unity3d.com/Manual/UnityOverview.html)t
hat will enable groups to create their own project. Each
group shall develop its own VR content after
downloading the software 
https://unity.com/download .

Group A: Design and animate a character
Group B: Create 2D Target Shooting Game 
Group C: Create a runner game
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Further Resources

Unity Main site
     http://www.unity3d.com/

Holistic Development with Unity
     http://holistic3d.com

Official Unity Tutorials
     http://unity3d.com/learn/tutorials

Unity Coder Blog
     http://unitycoder.com

Once the participants have completed the task, the
trainer will give them the opportunity to ask any
questions, or if there is anything specific that they wish
the trainer to show them. 

Present VR content developed (10 mins) 
Each group presents their project to all participants. 

Group discussion and evaluation (30 mins) 
The trainer and participants will take part in a group
discussion and talk about how they found the
workshop, including challenges, how easy/difficult they
found the tasks, how useful they feel this would be for
teachers.
At the end of the workshop participants will complete
an evaluation form providing feedback on the training
format. 
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SETUP
Download and Install

 Go to unity3d.com/download
 Use Download Assistant – pick components you want

Getting Started
First time running Unity you’ll be asked to create a project
Specify project name and location
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Workshop handout 
Introduction to UNITY
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Unity Interface
     • Toolbar, Scene, Hierarchy, Project, Inspector nt

Customizable Interface
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Building Scenes
• Use GameObjects:
        • Containers that hold different components
             • Eg 3D model, texture, animation
• Use Inspector
        • View and edit object properties and other settings
• Use Scene View 
         • Position objects, camera, lights, other GameObjects etc
• Scripting 
          • Adding interaction, user input, events, etc

GameObjects

• Every object in Scene is a GameObject
• GameObjects contain Components
         • Eg Transform Component, Camera Component
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Adding 3D Content

• Create 3D asset using modeling package, or download 
          • Fbx, Obj file format for 3D models 
• Add file to Assets folder in Project
• When project opened 3D model added to Project View
• Drag mesh from Project View into Hierarchy or Scene View 
     • Creates a game object 

Positioning/Scaling Objects

• Click on object and choose transform
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Unity Asset Store

• Download thousands models, scripts, animations, etc
• https://www.assetstore.unity3d.com/

UNITY BASICS

Making a Simple Scene
1. Create New Project
2. Create Game Object
3. Moving main camera position
4. Adding lights
5. Adding more objects
6. Adding physics
7. Changing object materials
8. Adding script behaviour

https://www.assetstore.unity3d.com/
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Create Project 

• Create new folder and project

New Empty Project 
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Create GameObject 

• Load a Sphere into the scene
• GameObject -> 3D Object -> Sphere 

Moving main camera

• Select Main Camera
• Select translate icon
• Move camera
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Add Light 

Add Physics 

• Select Sphere 
• Add Rigidbody component 
        • Add Component -> Physics -> RigidBody
        • or Component -> Physics -> RigidBody 
• Modify inspector properties (mass, drag, etc) 

• GameObject -> Light -> Directional Light
• Use inspector to modify light properties
(colour, intensity)
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Add More Objects 

• Add several cubes
         • GameObject -> 3D Object – Cube
• Move cube
• Add Rigid Body component (uncheck gravity)

Add Material

• Assets -> Create -> Material
• Click Albedo colour box in inspector
• Select colour
• Drag asset onto object to apply
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ICE BREAKING ACTIVITY “NAME VR GAMES”

Category 

Timeframe

Learning outcome

Materials

Procedure 

8-10 minutes

This ice-breaking activity gives participants the
opportunity to introduce themselves to each other and
learn what VR game preferences they might have (or
not). 
Participants will reveal their level of VR understanding
whilst they get to know each other. 

A tennis ball 

The trainer asks participants to get in a circle.
One person is given a tennis ball. This person says
their name and the name of a VR Game he/she
likes. Then he/she names the person he/she is going
to pass the ball to. 

The next person does the same, and so on. 
The activity continues until participants become
familiar with each other’s names and VR game
preferences.

Ice Breaking Activity

9 - VR Tools for Teaching
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Category 
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TEAM BUILDING ACTIVITY “A MISSION TO PLUTO” 

Timeframe

Learning outcome

Materials

Procedure 

1 hour

TAt the end of this activity learners should be able to:
• Working together in a hand-to-hand atmosphere to
define a dwarf planet 
• Making predictions and observations and drawing
conclusions 
• Having discussions and making claims grounded in
text evidence 
• Building empathy and taking the perspectives of
others
• Building comparison skills by contrasting Pluto to
other bodies in the solar system 
• Answering to media literacy questions • Comprehend
what virtual reality is
• Identify basic characteristics of VR environment
(environment simulation, interaction, graphics,
multisensory displays)
• Familiar with what VR content is 

Practical Team Building Activity

• Computers or tablets with internet access
• Colored pencils
• Lined paper
• Pens or pencils
• The NYT VR Video: “Seeking Pluto’s Frigid Heart” (View
on The New York Times or YouTube VR, 8 min.) 

Background information
On July 14, 2016, NASA’s New Horizons spacecraft zipped
past Pluto and its moons, scanning the dwarf planet in
unprecedented detail. Before this moment, the best
images of Pluto were only a few fuzzy pixels wide. In this
virtual reality video, learners will travel on New
Horizons, gliding through space at a million miles a
day. 

https://www.nytimes.com/interactive/2016/05/19/science/space/seeking-plutos-frigid-heart-nytvr.html?module=inline&mtrref=undefined&gwh=45F5889A681F7E1FA2EC2F66932BC47D&gwt=pay&assetType=PAYWALL
https://www.youtube.com/watch?v=jIxQXGTl_mo


They will fly over Pluto’s rugged surface and smooth
places, stand on icy mountains, and watch the moon
Charon rise on the horizon and touch down on a frost-
rimmed crater billions of years old.

Description of the activity
 The trainer asks participants to form two group space
force to board the New Horizons spacecraft traveling to
Pluto. As members of these teams, their goal is to
document their experience and share their insights on
the dwarf planet with their peers.
Before the mission to Pluto, the trainer asks team groups
to write down at least five facts they know about Pluto.
Indicative questions may be: 

What is Pluto? 
How big is Pluto?
Where is it located in the solar system?
What are some of its defining features?
How many moons are in Pluto’s orbit? 
Can life exist on Pluto? 

Then the trainer compiles students’ facts into a class list.
The trainer invites them to make a prediction based on
what they already know: What do they think it would look
like to visit Pluto?

During the Mission
The trainer asks the two groups to experience the NYT VR
video “Seeking Pluto’s Frigid Heart.” As they watch, they
should pay attention to Pluto’s unique characteristics.
After viewing, they should record what they observe
about Pluto: 
• Location in the solar system
• Surface features
• Temperature
 • Gravity 
• Moons 
• Atmosphere 

After the Mission 
After watching the video, each team prepares a report to
the space command center to share the insights they
gained on their mission. The trainer invites them to reflect
on the following questions in writing or discussion: 
• What was it like to “visit” Pluto in the V.R. film? 
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•  How close were your predictions to what you
experienced? 
• What do you notice about the way the message of the
VR film is constructed? 
• Colors? Shapes? Size? Sounds, Words? Silence?
• Movement? • Composition? Lighting? 
• How is the story told visually? Are there any symbols?
Visual metaphors? 
• What makes it seem “real”? The trainer invites the two
teams to demonstrate what they learned about Pluto by
creating an original drawing or series of drawings and
annotating them with key information about the dwarf
planet.

Further Reading and Viewing
 
Images of Pluto From NASA’s New Horizons Spacecraft
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At the end of the session the Trainer will have a
debriefing with all the participants to receive their
feedback regarding the workshop.

Indications or
suggestions for the
trainers (if any)

Category 

WORKSHOP “VR TOOLS FOR TEACHING” 

Exploration of different software applications
appropriate for education 
Workshop in groups of 4 about the different software
applications

Timeframe

Learning outcome

3 hours

The workshop aims at making learners to: 
Explore different software applications appropriate
for education. 
Identify the main aspects about them. 
Identify the challenges and opportunities they could
provide for learners. 
Reflect how teachers and trainers could use them in
class. 

https://www.nytimes.com/interactive/2015/01/13/science/space/photos-of-pluto-from-nasa-new-horizons.html?mtrref=undefined&gwh=E7496A4FA541803EA85BEF3B535708CE&gwt=pay&assetType=PAYWALL


Understand that applying VR in training and
education asks for certain frameworks and a lot of
preparation work 
Define situation - and target group-related criteria
and indicators

Procedure Instructions to the trainers

Activity 1 (1 hour) 

The trainer will take 5 minutes to explain the activity
to the participants. 
The participants will be divided into groups of 4. 
The trainer, before starting the activity, will set clear
rules: 

The focus of each group should be on quantity. A
good thought shower will generate many ideas; the
more the better. The thinking behind this is that
quantity naturally breeds quality. The more ideas there
are, the bigger the chance of an effective solution. 
Criticism is not allowed. People taking part should be
free to speak their mind.
New perspectives are welcomed. 

The trainer will indicate the website on which they
can observe the different software applications. 
 Each group will analyze all the webpages and they
will choose an application they think is appropriate
for educational purposes. 

 
A. Google Expeditions and Google Expeditions Pioneer
Program
B. Vive port: https://www.viveport.com/
C. Noda: https://noda.io/
D. Oculus Rift

They will have 30 minutes to carry out the analysis. 
At the end each group will explain to the rest of the
groups what they have found and why they think
their applications are useful for education and how
they would integrate it in class. They will also
analyze which are the strengths and weaknesses of
each of the tools.

Materials Internet connection Computer VR Equipment: VR
hardware (headset & controller) & software /apps Flip-
chart or pc/beamer 
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At this point the groups will be more realistic
Altogether, they are going to filter the ideas that
could work in class. 
Participants will then carry out a group reflection
about the ideas and analysis made previously. 

Activity 2 (1 hour)
 

After the previous analysis made in activity 1, each
group will find 1-2 free VR software that can be
useful to support students in class (10 min). 
They will download the apps and try them, just to
familiarize with the program, to experiment the way
they could use them, etc. (30 min). 
At the end they will need to reflect about the
experience, think about how the software could be
used, when, what considerations need to be
considered, the positive and negative aspects
about them, etc. (20 min). 

Activity 3 (1 hour) The trainer asks learners to set-up
a mind map structuring all criteria and indicators for
own VR teaching

In pairs or small groups, learners should try to
indicate all criteria and indicators relevant for their
own VR teaching they can think of (either on flip-
chart or pc/beamer)
The trainer collects all findings and develops in an
overall “live” mind-map
(https://www.mindmaps.app) 

Discussion and reflection: After the group has
developed an own mind-ma, the trainer may start a
discussion by raising some of the following questions
for reflection: 
- Which criteria and indicators do you find useful? 
- Which do not? 
- Which ones do you think are still missing?
- To what extent do you believe that you or your
institution is currently prepared and equipped to
actually use VR?
- What still needs to be done to enable the smoothest
and most meaningful use of VR? 
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